
How to make a timetable using Excel (or any spreadsheet program) 
Jimmy Judge – Garden State Central Model Railroad Club  -  9/19/2009 
 
 

The need for timetables: In the early days of railroads, trains ran “as needed”.  Because there were so few trains 
on the rails, often a train would leave the station when they felt like it.  Other trains could leave at same time from other 
stations and try to occupy the same tracks.  Slower train could "happen" to leave before a fast train needed to leave 
(passenger waited for local freight to clear tracks).  Granted, there weren't many trains on the line, but what a mess if 
someone decided that they've been waiting "long enough" and headed out, only to find out it wasn't long enough. 
 

The first time table was a posting by the B&O in May of 1830 in the "Baltimore 
Patriot" newspaper.  It was what became known as a Public Timetable.  The main 
purpose was to let the general public know what times passenger trains would be arriving 
and departing stations.  There were also poster sized versions of the public timetable at 
the train stations.   
 

The railroads also had Employee Timetables.  These kept all the employees 
abreast of the times of all trains on the railroad.  The first was created in 1841 by the Erie 
Railroad.  At that time, the timetables were all written out by hand on half sheets of paper.  
When there were only a small number of employees, this was not a big deal.  As the 
railroads increased their number of employees, this soon became a problem.  By about 
1847, there was more of a need than the clerks could write, so they began using printing 

presses to create the timetables.  During the civil war as the number of mainlines and branches increased, the railroads 
began experimenting with using a folded sheet to give them more area to print the timetables.  After the war, the printers 
began to pitch the idea of evolving the timetables from simply a sheet with dry numbers into more of a brochure with 
pictures and descriptions that the railroads could use not only as informational, but also promotional.  That's when all of 
the fancy covers and illustrations appeared on the timetables.  That format essentially remains intact today.  Here's an 
example of an Amtrak schedule. 

 



For this clinic, we're going to focus on the Employee Timetable showing all trains.  I'm going to gear this clinic towards 
creating a time table that you could use to run an operating session on your railroad. 
 
Timetables give "windows" of time for a train to operate safely on a specific section of track.  It allowed for more trains to 
move more quickly using the same section of track (one after the other).  It also allowed for scheduling of trains to avoid 
problems of a slower train holding up the mainline to all other traffic. 
 
Let's start a timetable for you: paperwork first 

• What type of commodities do you need to move (what type of railroad are you): Passenger, Freight, Coal, Fruit? 
• What locations on your layout do these things come from / go to? 
• Are there any sections of your layout that could "hinder" the movement of trains (single track, crossings, etc)? 
• Are there any named locations between your pick up/drop off points?  If not, do we need to name some? 

 
Make a list of all the stops and named locations on your layout in the correct order from one end to the other. 
Figure out the distance between the locations and write them down.  For our purposes, we'll mark the distances in scale 
miles or "smiles".  HO - 6ft, N - 3ft., O - 9ft 
 
Basic train flow: Passenger/General Freight: from one end to the other and back, Specialized (coal, grain, fruit): from pick 
up point to drop off point (do we need intermediate pickup/drop-off?).   Basic rule of thumb - general freight/specialized 
early to drop off work to be done during operating session, passenger next, general freight/specialized clean-up trains 
 
To make this timetable easier for your operators, use the Real Time not a Fast Clock because they already own a 
watch.....  You can make all your times reflect a fast-clock, that just changes some of the numbers in the calculations. 
 
Finally, Excel.  Any spreadsheet program will do (i.e. AppleWorks, Numbers, Works, VisiCalc).  Spreadsheets are good at 
adding numbers.  If we put the timetable in as a calculation, we can let the computer calculate the times for us.  Don't 
put in actual times.  We're going to use the locations and "smiles" we wrote down to create our timetable. 
 
Open Excel and create a new spreadsheet.  Go to the File menu and 
choose New.  If you have options, you’ll want a New Worksheet.   
 
Go down about 10 rows on the left hand side and type in the first location in 
column A, go down another cell and type the 2nd location, repeat. 
 

Start Time:  go up to row 3, column A 
and type Start Time.  Now select cell 
A4.  Let's name the cell start_time. 
(Make sure you put the underscore 
between the two words) 
Start Time: 
No blank spaces in cell names. 
To name a cell: 

Select the cell either 
 a) To the left of the formula 
bar type the name of the cell in the 
box with the cell number in it (B4) 
 b) In the Insert menu, select Name then Define.   
 
Type the name in the Names in workbook box and click on OK. 
Now let's pick a start time and put it in the cell.  Type 8:00 in that cell 
 
 

Set up the train numbers and information.  Let's go into row 6, column A and set up the train information.  In cell 6A, type 
Number, in 7A type Type and in 8A type Speed.  Guess what's going in these columns....  To start, let's just type a 45 in 
row 8 column B (next to the speed).  We'll talk about that more in a minute.  To make things easier, we’re only going to 
concentrate on ‘East Bound’ trains. 
 
Now let's start to work on the schedule for the first train. [Note: All of the times on the timetable are going to be considered 
"departure" times (i.e. what time the train is to leave the location).]  A train can arrive early, but is not allowed to depart 
until the time printed in the timetable. 
 
 



In row 10, column B, let's type in formula to start our train running. 
=TIME(HOUR(start_time),(MINUTE(start_time)+0),0) and press <Return>.  This tells Excel to print the hour & minute 
from the cell we named start_time in time format into this cell.  Now Excel knows that this information is not just typing 
(like the location names).  We'll talk about the +0 in a few minutes.  You should see 0.336806 displayed in the cell.  
What's this?  This is time displayed as a fraction, not time.  To fix this we need to format the cells to look like time. 
 
Highlight the cells from B10 to B27 (or what ever row your last location name is in) by clicking and dragging the mouse 
from the first cell to the last cell.  Then go up to the Format menu, select Cells and then a dialog box will pop up named 
Format Cells. Make sure the Number tab on the top of that box is selected.  You should see a list named Category.  
Click on the Time choice.  Now a box named Type will appear with all sorts of time formats in it.  We'll choose the one 
13:30.  This will just show the hours and minutes.  While you have the Format Cells box open, let's click on the Border 
tab on the top.  To make the timetable easier to read, let's click on the Outline and Inside boxes.  This will draw lines 
between all boxes that you have highlighted.  You'll see a sample on the screen.  Now click on the OK button on the 
bottom of the Format Cells box to make the changes. 
 
Math time.  I know everyone hates math time, but we have to do it.....  In cell B11 we need to type:    
=TIME(HOUR(B10),MINUTE(B10),(SECOND(B10)+(INT((3600/B$8)*1.5)))) 
Here's what the formula basically says: Take the time (hours, minutes and seconds) from the cell just above this one 
(hour(B10), minute(B10) & second(B10)).  Add to it the time it would take this train to move 1.5 "smiles" at 45 miles per 
hour (speed).  I need to break that down a little more - 60 minutes * 60 seconds -> 3600 is the number of seconds in 1 
hour.  If we divide that by the speed we're going (45 mph -> B$8) that will give us the time it takes to travel 1 "smile" (80 
seconds).  If we multiply that number times the distance to the next named location (1.5 "smiles") we get the time needed 
to go between the two named locations (120 seconds).  We take the integer of that number (the whole part-no fractions) 
and add it to the Seconds of the cell above this one.  Excel will adjust the time so it appears as 8:05 not 8:04:37 
 
Now that we have the first two stations done, let’s copy the formula in B11 and paste it from B12 down to the last location 
(B27).  That will give us times for all locations, but they won’t be correct.  Remember the *1.5 part of the equation?  That 
was the “smiles” between each location.  You’ll have to go into each cell, starting with B12, and adjust that part of the 
equation to the distance in “smiles” between the previous location and this one. 
 
Finally we have a complete set of times for one train.  We’re going to use column B as a template to build our other trains. 
 
OK, now let’s concentrate on the actual trains.  Remember what seems like days ago, I asked about what type of 
commodities do you need to move?  Well now it’s time to make trains up to carry each of those commodities.  Making a 
few basic assumptions, I think I’ll need at least a passenger train and a mixed freight train. 
 
To make the schedule for our passenger train, in cell C6, we’ll type JC Flyer to represent the first Passenger Train.  You 
can call this anything.  It could be JC101, #2 or anything that will let you recognize that train.  Next in cell C7 let’s type 
passenger as the train type.  I find that this makes JC101 or #2 have some meaning.  JC Flyer could be a passenger train, 
hot shot freight or a unit train of some sort.  Give the passenger train a decent speed.  Type 60 in cell C8. Highlight the 
schedule we just created in cells B10 to B27 and paste them into column C.  Did you notice that the times have changed 
slightly from the times in column B?  That train was set to move at 45 miles per hour.  It’s a silly little thing, but it makes for 
more prototypical operations.   
 
Time to add a mixed freight train.  Just like for the passenger train, in cell D6, we’ll type BGJC-102 to represent freight 
train #1.  On the Garden State Central, we use abbreviations for originating location and terminating locations as part of 

the train name (i.e. BGJC runs between Binghamton 
and Jersey City).  We also assign East Bound trains 
Even numbers and West Bound trains Odd numbers.  
It just helps to clarify things.  In cell D7, type mixed 
freight as the train type.  Leave 45 as the speed in cell 
D8. Highlight the schedule we created in column B 
and paste it into column D. 
 
Did you notice that the first couple locations have the 
same times as the JC Flyer?  They both leave at the 
same time and arrive at the first location at the same 
time.  We don’t want the trains to occupy the same 
track at the same time, so we’ll have to make an 
adjustment to the formula in the schedule.  Click on 
cell D10 and look at the formula.  We need to adjust 
the starting time so that the freight train leaves 



Binghamton AFTER the passenger train.  Remember before I said that we would talk about the + 0 in the calculation  
(MINUTE(start_time)+0).  It’s later.  That +0 is an adjustment we make to the start time of THIS train, not to the whole 
schedule.  If you change the + 0 to be + 15 and hit <Enter>, you’ll notice that the freight train BGJC-102 now leaves at 
8:05 or 15 minutes after the JC Flyer.  That’s the basic idea of how we can have one Start Time for the time table and still 
have individual trains start at different times.  Time to test it out.  Go up to cell A4 and change the time from 8:00 to 9:46.  
The times for the JC Flyer and BGJC-102 have all changed, but BGJC-102 still leaves 15 minutes after the JC Flyer.  
Neat.  Now when you’re ready to have an operating session at 8:00 and your guys don’t get settled in until 8:45, you can 
make a simple adjustment to the timetable and you’re ready to go.  No Muss, No Fuss. 
 
Just repeat that last step for each train that you want to add to the ‘East Bound’ schedule. 
 
Location Stops: Reading the column of times for a train is fairly easy, but how does the train operator know where he’s 
supposed to stop to pick up cars or passengers?  Remember that some of your locations are just ‘places along the way’, 
not station stops.  What I wind up doing to make it easier is simply make the cell time bold for station stops.  To do that, 
simply click on the cell you want to make bold and go up to the Format menu.  Choose Cells then the Font tab.  Change 
the Font Type to Bold in the box. Now the times stand out.  

 
What if a train doesn’t start or end at the ends of 
your layout?  Make a new train by copying 
column B and pasting it in column E.  Name this 
train #4, make it a passenger train and set its 
speed to 60.  We’re going to make this train run 
between Wilkes-Barre and Allentown.  Go to cell 
E10 and copy the cell.   This is copying the start 
time of the train.  Go to cell E17 (the Wilkes-Barre 
time) and paste.  Adjust the start time of the train 
by changing the +0 to +5 so this train leaves 5 
minutes after the start time.  Highlight cells E10 to 
E16 and either press the <delete> key (not 
<backspace>) or go to the Edit menu, select 
Clear then All.  This removed all the times for the 
stations before Wilkes-Barre that we don’t stop 
at.  OOH, AHHH.  OK same idea only we remove 
the stations after Allentown.  Highlight cells E21 
to E27 and press <delete>.  Train #4 is now only 
scheduled between Wilkes-Barre and Allentown.  
Done. 
 
 

Just so we know which direction the trains are traveling, go to cell D3 and type “EAST (read down V ) 
 
Time for the ‘West Bound’.  To make it easier to visually see the break between East and West Bound trains, make a copy 
of cells A6 to A27 and past them into cell G6.  Go to cell H3 and type “WEST (read up ^ ). 
 
I prefer to keep the town names in the same order on the East and West side of my schedules.  This way if a tower 
operator wants to take a quick look at what trains are passing through is area, he just has to look across the time table to 
see.  We also use a yellow highlighter to mark the line.  That means that for the train’s schedule, we start at the bottom of 
the column and work our way up towards the top.  Copy cell  A10 and paste it into cell H27 Since we named the 
start_time location, this train will automatically have a start time.   
 
Time to rebuild the schedule for a train, but this time we start from the bottom up.  Go back to cell B11,  copy the cell and 
paste it in cell H26.  This just gives us a copy of the equation so we don’t have to type it again, but we still have to edit it. 
=TIME(HOUR(H25),MINUTE(H25),(SECOND(H25)+(INT((3600/H$8)*1.5)))) 
We need to change all the H25references to H27 because we want to take the time from the cell after (below) this one as 
a starting point, not before (above) it.   
=TIME(HOUR(H27),MINUTE(H27),(SECOND(H27)+(INT((3600/B$8)*1.5)))) 
One last change, the “smiles” (1.5) in this formula are now wrong.  This was originally the “smiles” between Binghamton 
and Keyser Valley.  The number has to be replaced with the “smiles” between Jersey City and Phillipsburg (remember 
"read up"?).  Copy the edited cell H26 and paste it in cells H10 through H25.  Finally, edit the “smiles” in each of the cells 
to be the distance between the cell’s location (i.e. Easton) and the location after (below) it (ie. Phillipsburg).  That will 
leave you with a schedule for a train traveling “West Bound”.  Column H will be the template for the West Bound trains. 
 



Make a return trip for the JC Flyer.  Go to cell I6 and name this train Binghamton Zypher, set the type to passenger and 
the speed to 60.  Copy cells H10 through H27, and paste them in I10.  You could have two different locomotives and train 
crews operate the two trains, but you would have to have extra equipment and manpower.  The better thing to do would 
be to re-use the same loco and crew to work a "return trip" back to their starting point. 
 

That start time for the Zypher isn’t exactly what we 
want.  We really want the JC Flyer to make a turn 
around and head back out West as the Binghamton 
Zypher.  We want the Flyer crew to turn around their 
train (or just run the engines around to the other end) 
and then depart as the Zypher.  They’re going to need 
a few minutes to do that, so let’s say they need 10 
minutes.  Don't worry about the time, we can always 
adjust it later.  Let’s adjust the start time to make sure 
that the Zypher leaves Jersey City 10 minutes after 
the Flyer arrives.  Instead of using start_time as the 
starting time of the train, we really want to use the 
ending time of the JC Flyer.  Adjust the Hour and 
Minute of the equation by replacing the start_time with 
C27. 
=TIME(HOUR(start_time),(MINUTE(start_time)+0),0)    
becomes 
=TIME(HOUR(C27),(MINUTE(C27)+0),0)   Then 
adjust the +0 to +10 to give the crew 10 minutes to do 
their turn around.  Time to check out what we’ve done.  
Go to cell A4 and change the start time to 8:30.  All 
the times on the time table just changed and if you 

look, the Binghamton Zypher starts its journey 10 minutes after the JC Flyer arrived in Jersey City.  Now you can use one 
physical train to run as two different trains on the time table.  It also puts the trains back into their starting position for the 
next operating session. 
 
We can finish off the next two trains the same way we created the Zypher.  Make a return train for BGJC-102 called 
JCBG103  and #4 called #5.  Copy cells H10 through H27 and paste them in J10 then paste into K10.  Go to cell J6 and 
type JCBG103, J7 gets mixed freight and J8 gets 45.  Go to cell K6 and type #5, K7 gets passenger and K8 gets 60. 
 
Adjust the starting time on JCBG-103 by going to cell J27 and replace start_time to D27.  Here’s where it starts to get 
interesting.  How much time do you think it will take the crew to turn their set of engines for the trip back?  Should they 
wait there for a while to let the local switching crew go out and get cars for them to bring back East?  Here’s what I do for 
our operating sessions.  I have a road freight leave each end of the railroad early in the session. They drop off cars for the 
local crews to work on during the operating session.  Once they reach the other end of the layout, they go on break for an 
hour or so.  That allows the local crews to switch out their industries using the new cars they picked up in the beginning of 
the operating session, and get empties that need to be returned ready for pick-up.  Towards the end of the operating 
session I send those two road freights back out with new trains towards their original starting points, dropping off and 
picking up cars along the way.  For our example here, I’m going to have the road crew hold up for 20 minutes before 
sending them out again.  In those 20 minutes, they’ll drop off the train they arrived in Jersey City with (BGJC-102), fuel up 
the engines and couple up with the new train that they’ll be taking back to Binghamton (JCBG-103).  Adjust the +0 in cell 
J27 to +20. 
 
Time to set up #5 for the return trip.  Just like we did with #4, go to cell K27 and copy the cell with the starting time.  Go to 
cell K20 (the Allentown time) and paste.  Highlight cells K21 to K27 and either press the <delete> key (not <backspace>) 
or go to the Edit menu, select Clear then All.  This removed all the times for the stations after Allentown that we don’t 
stop at.  Highlight cells K10 to K16 and press <delete> to remove the locations after Wilkes-Barre.  Adjust the starting 
time on #5 by going to cell K20 and change start_time to E20, and adjust the +0 in cell K20 to +10.   
 
We have a working time table, but how does the traffic on our railroad look?  Are there any conflicts where two trains need 
to share the same track?  In the past (pre-computers), when the schedule maker wanted to look for conflicts, they would 
pull out their handy graph paper and pencil and actually plot the trains based on the time and location of each train.  They 
would look see where the lines that crossed.  Every crossed line is where one train passes another train.  If there were 
two trains passing where there were two pieces of track, everything should be OK, but what if there were three trains 
passing on those two tracks?  Now the schedule maker would have to adjust one of the three trains to pass that spot 
earlier or later than the other two.  After they adjusted the times, they would have to see if that caused another conflict.  
There could be A LOT of drawing and re-drawing until all the conflicts were removed.  Here's where using a spreadsheet 



to build our time table comes in handy.  We can tell the spread sheet to automatically graph all of our trains to make it 
easier for us to see where the conflicts are (or aren't).   
 
Making the chart is a two step process.  First we have to get the times grouped a little better for the chart, then we make 
the actual chart.  Look at the bottom of the spread sheet and see if there are three little tabs (they probably say Sheet1, 
Sheet2 and Sheet3)  If there is only one tab (Sheet1), we need to make another sheet for the chart data.  Go to the Insert 
menu and select Worksheet.  That will create a new blank sheet (probably called Sheet2). 
 
Double click on the Sheet1 tab and type timetable, then double click on the Sheet2 tab and type chart data.  This will 
make it easier for you to tell what information is on each of the worksheets.  Click on the timetable tab and copy cells A10 
to A27.  Click on the chart data tab at the bottom then go to cell B10 and paste.  That puts all the town names on the 
sheet.  Click on the timetable tab and copy cells C10 to E27 then click on the chart data tab.  Select cell C10 then go to 
the Edit menu and choose Paste Special.  On the bottom of the Paste Special pop-up, you'll see a button with Paste 
Link.  Click on that and then the numbers we copied from the timetable sheet will show up on the chart data sheet.  What 
we just did was paste a "link" to the times on the timetable sheet not the actual numbers.  Any time we make a change on 
the timetable sheet, the same change will show up on the chart data sheet.  Click on cell C27 and look at the formula line 
on the top of the sheet.  It doesn't have that 
=TIME(HOUR(B26),MINUTE(B26),(SECOND(B26)+(INT((3600/B$8)*0.5)))) 
It now shows 
=timetable!C27 
That's a link to cell C27 on the timetable worksheet.  The chart data sheet doesn't care how the timetable sheet came up 
with the number in cell C27, it just copies the number here on the chart data sheet.  Any time we change the times on the 
timetable sheet, the number will be changed on the chart data sheet. 

 
Put the train names on the chart data sheet.  Go to the 
timetable sheet and copy cells C6 to E6, go to the 
chart data sheet and just paste them in cell C9.  
There's no need to do any fancy paste links because 
the name of the train isn't going to change.  OK, let's 
get the rest of the train names and times onto the 
chart data sheet.  Go to the timetable sheet and copy 
cells I6 to K6, go to the chart data sheet and paste into 
cell F9.  Click on the timetable tab and copy cells I10 
to K27 then click on the chart data tab.  Select cell F10 
then go to the Edit menu and choose Paste Special.  
On the bottom of the Paste Special pop-up, click on 
Paste Link.   

 
All the times have been linked from the timetable sheet to the chart data sheet.  Trains #4 and #5 have a lot of zeroes in 
the locations that the train doesn't stop in.  On the chart data sheet let's remove them so they don't show up on our chart 
later.  Highlight cells E10 to E16 and press <delete>.  Repeat this for cells E21 to E27, H10 to H16 and H21 to H27. All 
that should be left is the times for Allentown to Wilkes-Barre.   
 
Fun time....  On the chart data sheet, highlight cells B9 
to H27. Go to the Insert menu and choose Chart.  In 
the pop-up window choose Line in the Chart Type: 
box then click on the Next button.  On the next screen, 
we won't worry about the source data so simply click 
on the Next button.  On the Chart Options window, 
click on the Gridlines tab and uncheck the Value (Y) 
axis  Major Gridlines and click Next .  On the Chart 
Location window we want to select the As new sheet 
button.  You can enter a name for the chart if you want, 
and click on the Finish button.  All of that just made a 
new chart that shows all of the trains on our timetable 
as lines.  You'll see the times on the left and the town 
names on the bottom of the chart.  A legend will show 
you which color/shape represents each train.  OOH, 
Pretty.  Now you can see why the schedule creators 
got out the graph paper.  This chart makes it very easy 
to see when trains will pass each other and how close 
trains run behind/ahead of each other. 



 
There are two kinds of adjustments we can make to the trains.  We can adjust the train's start time, which we did when we 
first set up the trains by +0 in the 
=TIME(HOUR(start_time),(MINUTE(start_time)+0),0)  
equation.  We can also adjust the time for a specific location stop by adjusting the minutes just like we adjusted them with 
the start time.  We can see from the chart that the JC Flyer and #4 both pass from Wilkes-Barre to Allentown at the same 
time.  Let's move #4's start time up from +10 to +52.  That will move it past the time that the Binghamton Zypher passes 
through on its return trip.  Go back to the graph and we can see that #4 does not have a conflict with any trains, but we 
would up adjusting #5 close to the times of JCBG-103 (remember that we made #5 start 10 minutes after #4 arrived in 
Jersey City?)  We’ll also have to adjust the start time of #5.  Go to cell K20 and change the +10 to +35.  Now we see that 
#4 will run in-between the Zypher and JCBG-103, while #5 will run after JCBG-103 with no conflict. 

 
We can see from the chart that BGJC-102 and the 
Binghamton Zypher are both passing through 
Packerton at the same time.  Let's say we didn't want 
the freight train near the passenger station then.  We 
can simply adjust the time that the freight train leaves a 
previous location (Allentown) to try to avoid the two 
passing in Packerton.  I thought that Lehighton is still a 
little close to have them pass, so I went back to 
Allentown to make sure that there will be a few minutes 
for the freight to hold up before the passenger goes by.  
Go back to the timetable tab and select cell D20.  Now 
we need to add the +15 to the minute  
=TIME(HOUR(D19),MINUTE(D19)+15,(SECOND(D19)
+(INT((3600/D$8)*0.5))))After you make the change 
you should go back and make that cell bold to show 
the engineer that he should wait at Allentown before 
leaving for Lehighton Lower Yard.  Go back to the chart 

tab and now it shows that there is plenty of time between the two trains. 
 
There may be plenty of time between the Zypher and 
BGJC-102, but look what happened to train #5.  Its 
running close to JCBG-103.  We have two choices:  
Change #5 to run before or after JCBG-103.  Let’s go 
back to our original 10 minute turn around on #5.  Go 
to cell K20 and change the +35 back to +10.  I did this 
to show you how making changes affects a lot of 
things and you may have to undo some of your 
changes that worked before. 
 
You may also want to adjust the time at a specific 
location to give your operators enough time to perform 
some task, like dropping of a cut of cars for the local 
switcher to use later.  To do that you would repeat 
what we did to BGJC-102 at Allentown.  Simply add 
an adjustment to the Minutes() part of the equation. 

 
Clean-up.  You can go back to the timetable tab and remove that first set of times we created.  Select columns B and H 
and delete the columns.  Highlight column B then go to the Edit menu and choose Delete.  Repeat this for column H.  
Those were only temporary times that we could use to copy and create new trains.  They are no longer necessary.  Notice 
that after you delete them, the times all stayed the same and even the chart didn't change.  That's the reason why we 
made that chart data tab.  You can make changes to columns that are not needed for the schedule without affecting the 
schedule or graph of the trains.  Excel takes care of adjusting the equations when you delete columns or cells. 
 
Finished……… 
A .pdf copy of the clinic can be found at http://www.gardenstatecentral.com/   Go go the Tips/Tricks button where you’ll 
find the clinic, and the Excel file I used in the clinic.  I’ve also put the schedules for the Garden State Central, Dave 
Albertson’s CNJ Coast Line and Rick Spano’s Sceniced & Undecided layouts to give you an idea how easily this can 
scale up to more than a dozen trains. 
 
 



Extra Credit. 
 
Now that you’ve got a feel for how to make the regular timetable, why not add a few pages that will make it easier for your 
operators to use.  When we run an operating session, everyone is given a copy of the full timetable.  That way Engineers, 
Brakeman and Tower Operators are all looking at the same information.  After we decide on a start time, the adjustment is 
made to the Start Time cell on the sheet, then we print a copy for everyone.  Most times we print the East Bound on one 
side of the page, then run them through the printer again printing the West Bound side (less paper to carry around). 
 
Open up the GardenStateCentral.xls timetable.  First off, on the Schedule itself, include any notes that you think the 
operators might need.  I’ve put the – All station stops are in Bold   as well as a few [Notes:] to let operators know about 
having to travel on the wrong main to get into Lehighton Yard.   
 

If you look at the bottom at the tabs, you’ll see the first three 
are the same that we set-up in the clinic.  Then it starts to get 
interesting.  You learned how to Paste Links with the graph 
calcs page to simply make a duplicate of a time.  The Engine 
Assign – Setup page is just an extention of that.  Remember 
during the clinic when we made the Binghamton Zypher a 
return trip for the JC Flyer?  This sheet would show the engine 
crew that they were called the JC Flyer on their East Bound 
trip and the Binghamton Zypher on their West Bound trip.  For 
example: Unit A – Passenger is a set of passenger power that 
will actually pull 4 trains during the operating session.  It will 
keep it’s basic consist of cars and simply run around them at 
each end to head back in the other direction.  So the 
dispatcher knows what assignments this train crew / motive 
power has, we simply list the train numbers from the timetable 
in column C, the starting and ending location in column D, 
then do a Paste Link of the starting times of each of those 
trains in column B.  Those engines are always going to be 
assigned to those trains for each operating session, only the 
times may be different.  Change the start_time, or adjust any 
of the individual departure times from a location, and this table 
is updated automatically.  The Car Assign – Setup page is 

similar except it lets the dispatcher know what cars need to be “staged” to run the trains on the schedule. 
 
 
The Layout Schematic tab is just what it 
says.  It’s a schematic of the layout with 
all the location names on it.  Since all of 
our mainline was double tracked, there 
was no need to show two lines.  What 
this does help with is to show where lines 
diverge and the relationship between 
locations.  Its nice to know which way the 
switches layout to know if you need to 
run around your train with the engines or 
not.  Remember, not everyone who 
comes to run your layout will know where 
Georgetown is.  Heck, some of your own 
members may not know.... 
(we used the blue boxes to show where 
you went through the wall and changed 
rooms.)  Now that note about running on 
the wrong main from Wilkes-Barre to 
Lehighton Yard makes some sense. 
 
The Tack Colors tab; We use magnets on top of each freight car to signify where it is to be delivered.  This page just 
showed what colors went to which locations.  All of that is in the Operations Clinic found on our website in the Tips/Tricks 
link. 
 
 



 
Finally is the Individual Train Schedules tab.  This tab works 
for the engine crews like the Engine Assign – Setup tab 
works for the dispatcher.  On the top part of the sheet, I 
duplicated the information from the Engine Assign – Setup 
tab.  On the bottom part of the sheet, I duplicated the 
information from the Schedule tab.  This sheet is given to the 
train crew that is assigned to Unit A – Passenger.  There is a 
separate sheet for each set of motive power.  The thought 
behind these is that if I’m on the crew that’s assigned to Unit 
A, this is much easier to read than trying to find my trains 
listed in the full schedule.  Each road crew (engineer and 
brakeman) would have a copy of the full schedule and the 
individual schedule for their Unit. 
 
 
 
 
 
 
 
 
 

 
There you have it.  That should be way too much information for you to make your own schedule for your layout.  Don’t 
think you need to have a club sized layout for these schedules to work.  Granted, Rick Spano’s schedule is for a big home 
layout, and working in N gauge makes it seem even bigger.  Dave Albertson’s schedule is for a medium sized home 
layout.  Take a look at the scale miles he has between stations, they aren’t that far apart.   
 
If you have any questions, feel free to drop me an e-mail.  You can reach me at the Garden State Central’s e-mail 
address:  gsc_webmstr@hotmail.com 
 
Good Luck. 
 
 
 
 
 
 
 
 
 
 
 
 
 


